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Warnings, Cautions and Notes

Definitions

WARNING Could cause body injury or death.
CAUTION Could cause damage to equipment or permanent loss of data.

NOTE provides useful information to the operator.

Important Information - Read before using the Instrument

WARNING - Laser Radiation is emitted from this device. Do Not stare

into Laser Beam. Class 2 Laser, 635 nm, 0.9mW

CAUTION - Never point the lens directly toward a strong radiation source

(ie. Sun, direct or reflected laser beam, etc ), with power on or power off, as
damage may result to the thermal detector used inside. Permanent

damage may result!

CAUTION - The original shipping carton should be kept for use for future

transportation. Do not drop, shake or impact the thermal imager

excessively, in use or during transportation.

CAUTION - Store the unit in its original case in a cool, dry, well-ventilated

area away from strong electromagnetic fields.

CAUTION - Protect the surface of the lens from being stained or damaged

by foreign objects such as sludge or chemicals. Please replace the lens cap

after use.

CAUTION - Please remember to backup image data regularly to avoid

losing important data.

NOTE - For maximum measurement accuracy, allow 3 to 5 minutes for



camera to stabilize after initial power up.

NOTE - Each camera is factory calibrated. It is recommended that

calibration be performed every 12 months.

CAUTION - Do not open case. Unit does not contain any user serviceable

parts. Repair should be performed by factory authorized technicians only.
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Introduction

Thank you for choosing Sensor Partners “Thermoview P-64" hand-held

infrared thermal imager.

Features

The Thermoview P-64 includes the following features:
11 user selectable color palettes
11 user selectable languages
1- 8 X digital zoom
10 removable spot measurements
5 areas measurements
2 lines measurements
Shortcut key custom
Auto focus
Manual focus
Bluetooth
WIFI
Power save mode
LCD brightness adjustment
Video Output- NTSC or PAL
Network settings
Time/date settings
Restore factory settings
SD card unload,formatting
SD card capture, video saving
Voice capture or text annotation
Continuous image capture

Alarm screenshots



Alarm video
Isotherm
Temperature measurement settings

Built in Emissivity Table list of common materials

CMOS visible image and storage
Thermal image and CCD image fusion

High/low temperature fusion

Upgrades and Options

The P-64 is factory upgradeable for Wide Angle or Telephoto Lenses.

Applications:

Preventive maintenance
® Power industry: Power line and power facility thermal state checking;
problem and defect diagnosis.

® Electrical system: Identify potential circuit overloads.

! Mechanical system: Reduce downtime and avoid catastrophic failure.
Construction science

® Roof: Quick identification of water penetration problems.

® Structure: Commercial and residential energy audits.

® Moisture detection: Determine root cause of moisture and mildew.

! Evaluation: Evaluate the resolution to ensure the area completely dry.
Others

® Iron and steel industry: Inspect steel refining and rolling processes;

diagnose hot-blast stove defects; detect the embryo temperature of armor

plate, etc.



® Fire fighting: Forest fire prevention and detection of latent ignition
source. Preventive detection on specific materials of auto-ignition. Detection
of potential spark ignition sources.

® Medical: Human body surface temperature detection and screening.

! Petro/chemical: OQil pipeline status inspection; material surface

temperature detection; insulation inspection; power equipment status, etc.



1.1 Standard accessories

Infrared thermal image camera (with wrist strap and lens)
® Shoulder strap

® Carrying case

® Video out cable

® Lithium ion batteries (2)

® Charging dock

® Lithium battery charger

® Lens cap

® User manual, Infrared report and analysis software system CD
® SD card

® SD card reader

® Network cable (Mini-USB to R1J45)

1.2 Optional accessories

External 0.5x wide-angle lens
® External 2x,3x telescopic lens
® Carrying case

® AC adapter(include power line)
® Europe standard power line

® Tripod



2 Camera overview

2.1 Function keys




[1] Power key
Press and hold the Power Key for > 3 seconds to power on/off the camera
! Note: After powering off, please wait ten seconds before powering the

camera on again

[2] Menu/Confirm key

Includes Up, Down, Left, Right and Menu/Confirm (center) keys.
Function varies with operation mode.

In Menu mode, it is used for menu selection. Up and Down keys are for
same level of menu operation. Left and Right keys are for different levels
menu operation. Confirm key (center) is to activate the menu and confirm the
choice.

In Image mode, press Up or Down key to activate X2 digital zoom. The
screen will display “X2"” in the upper left corner. Press Up or Down key to
return to the original image.

In Spot Measurement editing mode (activated immediately after adding
a spot or by selecting via the A key), press the Menu key to pop up the
attribute box. Press four navigation keys to move the spot location.

In line temperature measurement editing mode (activated immediately
after adding a line or by selecting via the A key), press the Menu key to pop up
the attribute box. If measurement line is horizontal, press Up and Down keys
to move the line location; press Left and Right keys to move the reference line.
If measurement line is vertical, press Left and Right keys to move the line;
press Up and Down keys to move the reference line.

In area measurement editing mode (activated immediately after adding an
area or by selecting via the A key), press the Confirm key to pop up the
attribute box. Select in the attribute box the parameter to be edited, either size
or position. Press the four navigation keys to move the area location or change

the size of the area.

[3] Cancel/Auto Focus key (Marked “C")
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® Pressing and releasing the C key cancels the present operation when in

Menu mode.

® Pressing and releasing the C key when an image is frozen or being viewed

from memory, will return to real-time measurement status.

® When a parameter is selected, such as a measurement cursor, pressing the

C key will delete the highlighted measurement.

® Press and hold the Key for > 3 seconds to auto focus

[4] Freeze/Save key (Marked “'S")

Used for freezing or saving thermal image. Short press the key once to
freeze the image , Press C to return to real-time measurement. Short press
the key twice to save the image . In file management, press the key to choose

whether delete the chosen image or video.

[5] Select/Auto key (Marked “A")

The “A” or attribute button performs 3 functions.

a) The first function is modification of selected parameters. It is obtained
by a quick press and release (less than 2 seconds), with this functions to
modify their parameters. Subsequent presses will “scroll” through the
available parameters. The selected function will be highlighted in
yellow.

b) The second function is calibration. Press and hold the Key for > 3
seconds for auto calibration to get accurate temperature measurement
result.

c) The third function is blue tooth. Open blue tooth, select the image, short

press to send the image.

[6] F1 Trigger/Shortcut key
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The standard configuration is to save the image
[7] Laser switch

Short press to turn on the laser, press again to turn off. In menu there is

auto turn off laser option ,the standard configuration is 60s.
[8] F2 Key
Short press to switch thermal image /CCD image/fusion mode.

Long press to turn on the LED light. In menu there is auto turn off LED light

option , the standard configuration is 60s.
[9] F3 User —defined Key
The standard configuration is to switch temperature range

F1,F3 is user defined key, except standard configuration, it can define

below functions:

Image playback, record-short press to enter image playback or start

taking video
Light-press once to turn on the light, press again to turn off the light

Spot, area temperature- press once to add spot or area, press again to

delete the spot or area

LCD brightness adjustment- press once to pop out LCD brightness

adjustment bar

Fusion transparency-press once to pop out fusion transparency bar

[10] Microphone

Used for voice annotation when saving the image
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2.2 Interface

13 ‘ 12

14 ——— | I 1

[11] Video output

It is a video output interface

[12] Network interface

Use network cable (Minu-USB to RJ45) to connect Internet

[13] SD card slot

Accepting standard size SD card such as supplied 8GB capacity card, for

device upgrade or image storage

[14] Power interface

External power input interface. Power source should be +12VDC. Center

pin is positive terminal
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3 Basic operation

3.1 Battery Installation and Replacement

3.1.1 Inserting or removing battery

Battery compartment is located at the end of the camera, below the view

finder.

Insert the battery (the battery contacts must face into the battery

compartment),promote it until the battery lock is locked.

Triangle
mark up

When inserting the battery, note the triangle mark direction should upwards,

do not overexert to damage the camera or battery

15



Lock button

I CAUTION: Use only original manufacturer replacement battery. Use of
incorrect battery may result in physical or electrical damage to the instrument

due to incorrect voltage or physical size difference.

3.1.2 Replacing battery

When battery has approximately 5% charge remaining, the warning will be
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displayed and the instrument will turn off in approximately 10 seconds.

Powering off display!

Powering off display

It's better to replace batteries now.

3.2 Battery safety and usage

> Batteries should be stored in an ambient temperature of -4°F (-20°C) to
67.9°F (4+20°C). Lithium batteries will self-discharge during storage, so
they should be fully charged before storage. Self-discharge may affect long
term battery performance. Furthermore, it is recommended that the battery
should be charged in a set time, as below;

Ambient temperature of:

® -4°F (-20°C) to 67.9°F (+20°C), once every 6 months
® 67.9°F (+20°C) to 113°F (+45°C), once every 3 months
® 113°F (+45°C) to 149°F (+60°C), once every month

> Battery should have greater than 50% charge prior to recharge.

» The ambient temperature for charging should be 32°F (0°C) to 104°F
(+40°C). If under 32°F (0°C), the battery capacity will be diminished; if
over 104°F (+40°C), the battery may overheat, resulting in permanent
damage.

! WARNING:

! Never disassemble, incinerate or puncture battery
! Never short circuit the battery

! Keep battery dry

! Keep out of reach of children
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! Always dispose of battery in accordance with local, state and federal
regulations

3.3 Quick access

3.3.1 Capture an image

® Afterinstalling the battery, press and hold the power key (=3 seconds)
until the display comes on. After approximately 50 seconds, the power
on routine will finish and the camera will start its measurements.

® Remove the lens cap and aim at the target. Adjust the focus for the
clearest target thermal image.

® Press A key for auto calibration to get the best image

® ! NOTE: Failure to properly focus the camera will result in increased
measurement error. When the image quality become worse or ghost
image appeared, please press button A for a long time to compulsion in
force.

3.3.2 Temperature measurement

» If no measurement cursors are on screen, add a measurement spot,
area or line by pressing MENU and selecting Measurement. Press
CONFIRM and scroll left or right to select the proper measurement
parameter. Aim the cursor indicator onto the target object on the
screen. The temperature will be displayed in the upper right corner of
the screen. For highest accuracy measurements, force a calibration
cycle by pressing the A key for 3 seconds until “Calibrating” appears
in upper left portion of display.

® If you want to measure the current thermal image in detail, press S
key to freeze the image for on-screen analysis. Save the image if
future analysis is desired.

® If the target object’s temperature is lower or higher than the limits of
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the camera, it will display <XXX° or >XXX° with XXX being the min or

max temperature of the selected range.

To modify the measurements attributes, select the measurement
parameter, and then press the Confirm key. The screen will display
the settings dialog box. The below figures are spot, line and area

measurement respectively.

Point Properties £

Distance 2.00>
Measure Type >
Ref object off >

Spot attributes dialog box
Spot attributes can amend emissivity, distance and reference
temperature. When Set Ref is set as Yes, the displayed values of other

measurements will be their delta from this measurement.

Line Properties £

Distance 2.00>
Measure Type >
Ref object off >

Line attributes dialog box
Line attributes can amend emissivity, distance, highest temperature,
lowest temperature, average temperature, max temperature
difference, the cross point temperature and reference temperature.
Press A key for up and down switch. When Set Ref is set as Yes, the
displayed values of other measurements will be their delta from this
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measurement.

Area Properties £

Distance 2.00>
Measure Type >
Ref object off >

Area attributes dialog box
Area attributes can amend emissivity, distance, highest
temperature, lowest temperature, average temperature, max
temperature difference and reference temperature. Left and right key
for choice, press A key for up and down switch. When Set Ref is set as
Yes, the displayed values of other measurements will be their delta

from this measurement.

I NOTE: Thermal camera can only select one reference temperature

object

3.3.3 Freeze and save image

There are three ways to save the image:

1.

Press S key to freeze the image and then select "Save” to save the
image, or select "Cancel” to exit the operation.

Press Menu key to activate the main menu. Choose File->Save and
the system will initiate the save cycle.

With the “Trigger” parameter, located in Setup->Sys. Setup->Trigger,
set to "Save Key”, pulling and releasing the trigger key will initiate the

save cycle.

3.3.4 Viewing stored Images

Two way to open the image file:

1. Press the Ok key to activate the main menu, select "File Manager" menu ,
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then select the submenu (via the arrow keys to select)
2. Click the "Preview" option in the floating panel to open the selected file

(via the left and right keys to switch selection)

® After you open the image, you could use upper and lower sections of the
playback control panel keys to playback the current store images.

® Press Cancel key to exit and return to the current state.

3.3.5 Export saved images
Can use card reader to download, delete, format the TF files.
! Note: It is recommended to use the thermal camera curing

formatting capabilities in software for SD card format
3.3.6 LED screen settings

There are two ways for settings:1. Press Menu key to activate the main
menu. Choose general settings->LCD brightness adjustment to
adjust LED screen brightness. 2. Set shortcut key to LCD brightness

adjustment to adjust LED screen brightness.

3.3.7 Menu operating instructions

® Keyboard operation: press the "OK" button to pop up the floating panel,
use left and right arrow keys on the floating panels to select the icon, click
"OK" key to enter the relevant interface.

® Main menu interface: via "up and down" key to select the menu icon, click
"OK" key to enter the submenu.

® Sub-menu interface: via "up and down" key to select, if there’s the ">"
mark, using right-click to enter the lower menu

® Parameter interface: The "up and down" key is to modify, the “left and
right” key is to choose

® < > means modify the setting of the current menu.

® Press the "OK" button to confirm the changes, save and return to the
previous menu, press the "C" key to cancel the changes and return to the
previous menu.

| | |
° — Cancel and return to the previous menu button; Save and

return to the previous menu button. (For touch screen)
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o« T Switch button, by the left and right keys to modify the switch

settings

4 Operation guide

4.1 Graphic interface description

4.1.1 Screen graphic interface

271 ._ 7 e = 0.96

4 30.5 P1
5 7 91.0 R1_HI

Screen graphic interface
[1] Company logo

[2] Emissivity: the current emissivity setting

[3] Reference Temperature: Fixed reference temperature

= =]
(=]
=

n
(D)
L2
ﬁ
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[4] Result: Indicates the temperature value of the target object. Black and
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yellow denotes the temperature value of the selected object.

[5] Spot temperature measurement: white crosshair

[6] System time: the current system time

[7] Battery status: Indicates the current battery status.

[8] Manual/auto enhancement mode: choose manual or auto mode
[9] Min temperature: indicate minimum value of the palette

[10] Palette: palette bar. User can choose different palettes

[11] Calibration/freeze: indicate the calibration status or freeze status
[12] WiFi: WiFi is open will change along with WiFi signal
[13]Bluetooth: select Bluetooth function

[12] Max temperature: indicate the max value of the palette

[13] Battery status: indicate the current battery status

[14] Lens: 0.5x or 2x

[15] Record: current record status.
Continuous capture mark D;

Record mark

[16 SD card: indicate the TF card load status

[17] Mode switch: current mode.

IR mode-, CCD mode , fusion mode. o
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4.1.2 Floating bar interface

Floating bar interface

Floating bar interface: from left to right, up to down is adding spot, adding

line, adding area, delete, taking photo, record, playback and
main menu

4.1.3 Main menu

Main Menu

The main menu items: display the main menu item, namely the document
management, temperature settings, image settings, camera
settings, general settings, network settings, SD card

management and system setting.
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4.1.4 Sub-menu interface

) Emissivity
TCorrect
Distance 3
Humidity
TReflect 4

Sub-menu interface
[1] Figure name: Displays the name of the dialog box. The name of the
dialog box as shown in the example is "temperature measurement setting.
[2] Item title: A dialog box may contain more than one item. As shown in the
above figure
[3] Item Content: each item corresponds to the content of a project, the left
and right keys to make changes, ">" indicates the lower
menu.

[4] Parameter options: press the left button to select a different parameter.

4.2 Measurement Object Adding

This feature is used to increase or clear the measuring object. The
following dialog box pops up, press the Enter key, floating menu pops up,

select the temperature measurement target to add and press the Enter key.

Temperature Measurement Object Adding Menu
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If select “m”, then press OK key, then the all the objects will be

cleared.
I NOTE: When you delete a single temperature measurement object, direclty

press “"A” key and choose the object, then press the "C" key to delete.

4.3 Recording

This function is used to save the video, save format to MP4. Pressing the
Enter key, floating menu pops up, select video and press the Enter key, as
shown below

Recording Figure
Press stop key to end the recording, and return to the current operation
status

4.4 Photo

This item is for photo. And back up in the JPG format. Pop up the floating
menu after pressing confirming key. Then finish the photo. If turn up
function of mark. Backup note will pop up in the OSD as followed.
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Link Recording?

Start Exit

Voice record note for photo
Continuous photos mark will appears in the status column if set the

continuous photo

4.5 Preview

This item is for the preview files of backup. Press confirming key. Pop up
the floating items , select preview and press confirming key will appears as
followed .

BF)

Playback

Preview OSD
Switch to files by pressing key of left or right. Open it and it appears in the

screen by pressing confirming key. Press C key to quit
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4.6 Settings

File management
Lt 1
o) B

Image setting

General setting

GB .

SD card management

Main OSD

4.6.1 General setting

Temperature measurement setting

Imaging setting

Photo&video capturing

System setting

[ Auto-calibration interval 60S >J

i, [ Shortcut keys def >J

= Y [ Bluetooth off >J
ad [ Power-saving mode >J
[ LCD brightness adjust < 20% >J
c. IR [ temp unit < °C ,J
. [ Distance unit <m >J
25 08507 [ Video out >J

General setting OSD
Press confirming key will pop up the panel and select the SETTING to open

the main menu. Select the general setting in the main menu. General setting

OSD will pop up after pressing confirming key. Users could set the time of auto

calibration / definition of shortcut key /Bluetooth/pattern of power saving/

brightness adjustment of LCD / unit of temperature / unit of distance/external

video output switch .totally 8 items. Switch to items by pressing key of up or

down. Change the value by pressing key of left or right. “>” means secondary

-menu and enter the menu by pressing key of right .

28



Time of Auto calibration: Set time interval of auto calibration to get
better thermal image and improve the precision. The

unit is second

Defined value

[ Short Time(60S)
[ Long Time(180S)

General

25| 08207

Auto calibration OSD

Shortcut key : Users could set the Functions of shortcut key. System
offers image saving, temperature range switch, image
playback, record, LED light, OLED light brightness
adjustment, transparency adjustment, adding or delete spot,
adding or delete area options for choice . When select
shortcut key of light. It will open the lighting. Then it closes.
When select shortcut key of spot 1. It will add or remove the
spot 1. When select shortcut key of area 1. It will add or
remove the area 1. When select shortcut key of record. It
starts to record. When select shortcut key of photo. It starts

to save the photos you took

29



capture J

Change Temp Clas%

125/ @E07

Shortcut key setting

Power saving : Screen off and power off

Time of screen off : If without any operation , thermal imaging camera
will screen off to save power. Press any key except the
power key, thermal imaging camera will screen on . This
function is not valid when time is set to 0 minute.

Time of power off : If without any operation , thermal imaging camera

will power off to save power. This function is not valid when time is set to

0 minute.

Off-screen Time OMinites

Off-machine Time OMinites J
Auto-off Time }

Power saving OSD
Auto off time : include laser and LED auto off time, used for auto off when

the laser or LED turn on, the default time is 60s
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Laser auto-off time J

Led auto-off time }

Auto off time OSD

LCD brightness adjustment : It is valid when changing the brightness

v

Auto-calibration interval 60S

v

Shortcut keys def

W

o] C==
Fy
v
A A R N N oA

Bluetooth off

Power-saving mode

g‘g%! Ie3

LCD brightness adjust < 20% 2

. temp unit < °C»
. Distance unit ¢m >
25/ 0967 Video out >

LCD brightness adjust OSD
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46.2 Temperature measurement setting

-40/180°C
Standard

20.0°C
off

Temperature measurement setting menu

Press OK button to call out the Setting Menu. Select "Measuring Setting”,
then press “OK” again to call out the setting interface. In this
interface ,level ,magnification, Environment Temp, Ref Temp, adjustment,
object temperature can be set. Use UP & Down button to select ,” >” means
there is sub menu, press Right Button to enter the sub menu.

Level: Setting the Measuring Level of the thermal camera.

Magnification: Setting the Magnification and the different Temp range.

Environment Temp: It will automatically detect the Environment Temp

after the camera start-up.
Ref Temp: When itis enabled, the target temperature shown on the LCD

is the D-Value between the real temp and the Ref-Temp.

[ Ref object off ]
[ Ref Temp 20.0°C }
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Ref Temp Menu
Object temperature: When turn on object temperature, the temperature

target display the object temperature in the bottom right corner

4.6.3 Adjustment

3

Emissivity 0.96 -
TCorrect 0.0°C

2.0m

Humidity 60%

TReflect off

Treflect value 1.1°C

Y Y Y Y
O
0
—+
jui}
=
2l
o

Adjustment Menu

Press OK button to call out the “Adjustment” under menu “Measuring
Setting”. In this menu , Emissivity, Tcorrect, Distance , Humidity ,TReflect can
be set. Use UP &Down button to select ,use LEFT & Right to set the value. ” >”
means there is sub menu, press Right Button to enter the sub menu.

Emissivity: Different target has different emissivity, so the user can set
different emissivity for different target. If it is not set , then will
use default setting. Attached Common emissivity table for
reference.

Tcorrect: Correct the target Temperature.

Distance: Setting the distance between the camera and the target to
make sure exact measuring. Set the real distance if the distance
is shorter than 10 meters. (unit 0.5m)

Humidity: Set the humidity of the using environment.

TReflect: It will only functioned after it is enabled. Can use fixed temp as

reference temperature.
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4.6.4 Image settings

Auto-enhance mode

IR transparency

Alarm settings

Isothermal setting

Merge set

Video output

26/ @207

Image Setting Menu

Press OK button to call out the Image setting menu under “Setting” . in this
menu , Manual/Auto-Enhance Mode, IR transparency , Alarm setting ,
Isotherm, IR fusion, video output can be set. Use UP &Down button to
select ,use LEFT & Right to set the value. ” >” means there is sub menu, press
Right Button to enter the sub menu.

Manual/Auto/Auto-Enhance Mode: Adjust the image quality for the
user to get better image for analysis purpose

When Auto-Enhance Mode is activated, can switch between manual and
automatic. Press "A “ button will enter manual mode, it can adjust the pallet
with “UP, Down, LEFT, Right” buttons. Press “C” will return into Auto Mode.

When Auto-Enhance Mode is deactivated, can switch between manual and
automatic. Press "A " button will enter manual mode, it can adjust the pallet

with “UP, Down, LEFT, Right” buttons. Press “C"” will return into Auto Mode.

The modes can be switched with the Auto-enhance mode Button.
If select auto mode, the camera will automatic adjust the sense of hierarch
icy of the image.

If select "Auto-Enhancement ™, both High temp target and low temp target
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can be viewed in the image.

If Select Manual mode, User can set the pallet value to adjust the image quality.
Press “"UP” button to increase the level range , press Down to
decrease the level range. Press Left button to reduce the upper
limit, increase the bottom limit; Press RIGHT button to increase the

upper limit, decrease the bottom limit

Alarm types

Alarm color

Alarm temperature

Alarm link

Time interval

Record time

Y Y Y YT N

25/08:07

Alarm Setting

Alarm Types: It is only functioned when measuring. User cab set alarm
OFF , High temp alarm, Low temp alarm here. It will alarm
when proper setting is selected. Alarm color can be set in “"Alarm
Color”

Alarm Color: The color of the target area shown on the LCD will be
changed into the alarm color set when the temperature is over
the alarm temp. 9 color types can be selected. If “colorless” is
selected, then the color will not change when alarm.

Alarm Temperature: Setting alarm Temperature. Only functioned when

it is enabled.

Alarmlink: It will automatic saved when there is alarm including

snapshots and video record.
Time Interval: Set the alarmlink time interval.

Alarm video time: set alarm video time, can choose to turn off
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Isothermal switch

Max isothermal area

[ Isothermal color
[ Min isothermal area

Isotherm Setup Menu
Isotherm: Activates the Isotherm display by displaying the image in the
set temperature range by the specified color.
Isotherm Color: 9 colors available for your choice, Setting to Off, disables
the feature.
Isotherm low value: Set the Isotherm low value

Isotherm upper value: Set the Isotherm upper value

MergeType Close }
MergeTemperature }

IR Fusion High & Low temperature Menu
IR Fusion High & Low temperature:
It consists of three options--IR Fusion High Temp, IR fusion Low Temp, and
OFF. Set IR Fusion High Temp, when the actual temperature is
higher than the temperature of IR fusion set up, CCD image

will be shown. Vice versa.
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4.6.5 Network settings

IP address 192.168.0.2
Subnet mask 255.255.255.0

Default gateway 192.168.0.1

Link Type 100M

Wi-Fi

Internet

Network Setup Menu

Press the menu button to show up the floating panel and choose the
“setup” option to active the main menu. Select "Network function.

IP Address: This IP address must be the only one, can not be conflicted with
the other IP address of the same network segment.

Sub network mask: Divide the segment of the sub network.

Default network gateway: Set the gateway address to realize the

communication among different segment.

4.6.6 SD card management

[ SD card 1317M /1882M }

Remove Format

Confirm to remove

OK Cancel

SD Card Management Figure
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[ SD card 1317M /1882M ]

Remove Format

Confirm to remove

OK Cancel

SD Card Format Figure

Press the Enter key to pop up floating panel, then select "Settings" option
to activate the main menu, select the "SD Card Management item in the setup
menu.

Unload: Unload SD card.

Format: This function is used to format the SD card. Select the
formatting options, pressing the confirm key to format, press cancel or "C" key
to cancel the formatting

I Note: Verify that the file is no longer needed or have been backed up
before formatting; after formation, the saved thermal imaging pictures will be

lost unrecoverable. If format by PC, please select FAT32 to format the card

4.6.7 Capture setting

LinkCapture

PicNoteWay

Consecutive number

Consecutive interval

Directory settings

Capture setting menu
Pressing confirm key to pop up the floating panel, then select "capture
Settings" option to activate the main menu, selected the camera settings
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option
Associated Pictures: This function is to associate the infrared images
with digital image, to save the picture together.
Image annotation mode: This option has two kinds of annotations,
audio annotations and text annotations. Audio annotations is to add voice
when you save the picture; text annotation is to add text messages when save
the image.
CS Shots: Set Continuous capture the number of sheets can be set for 1,
3, 5, 10 shot.
Continuous Capture Interval: can be 0.5s or 1s.
Menu Setting:

{ Directory types By date }
[ Defined path /DCIM/ J

r
m
Ge Q

Camera

25 @807
Menu Setting
Set the path to save the file, directory type can be set by custom, by month,
by date. In preview mode, the playback file path set by directory type

4.6.8 System settings

Language

Date/Time format

Recover default

Device NO:23707C10002
Version: V1.01
MAC: 00:00:44:4C:52:33

[
[
[ Date/Time
[

Input

System Setting Menu

39



Press the Enter key to pop up "Settings" option to activate the main menu,
select "System Settings" item in the setup menu. Users can customize the set
system language, time / date formats, time / date, restore the factory value
items. Pressing the up/down key to switch the setting, use left and right arrow
keys to set the contents of the setting. The ">" indicates that there’s a
lower-level menu, use right-click to enter.

Language: Set the languages

Time / Date Format:

[ Date format YY—MM—DD}
[ Time format 24-hour ]

Time/Date Setting Menu
Change the format of the time/date

Time Setting:

e | B

Date format YY-MM-DD

Stk - 02 - 25 09 |07 am

Time Setting Menu
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Customer can via the Time Setting menu to set the thermal imaging
camera’s time. After the setting, the data the time will be saved.
Users can customize to set the year, month, day, hour, minute entries.

Press the left and right key to do the settings.

! Note: When left unused for a long time, due to the limited internal battery
power, the thermal imaging camera need to re-adjust the system time.
Restore the factory settings: This function is used to restore the factory

settings. Pressing the confirmation button, the setting menu will come up,
continue to press the confirm key system to restore the factory settings. When

pressing the cancel button to exit, the restore the factory settings will be

cancelled. The details of the thermal imaging camera’ factory parameters

listed please see the Annex parameter table.

W S

English

Lead Default ?

OK Cancel

Device NO:23707C10002
Version: V1.01

L

MAC: 00:00:44:4C:52:33
Input Output

125 0307

Recover Factory Setting
I Note: Recover factory setting will cancel all user-defined parameters.

System Version Info:

e

Device NO:23707C10002
Version: V1.01

MAC: 00:00:44:4C:52:33

b

System Version Figure
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Display thermal imaging device, device number, software version number
and MAC address
Import: New SD card the Create DCIM / Import directory on the SD card,
import the fixed file name as PicNote.cfg
File Name Form:
[Note]
Notel =

Note2

Note3 =
Each line is not more than 20 words. After the import is complete, restart
the instrument to take effect.
Export: TF card, make sure the SD card is in the machine, then select the
menu and then click the Export button to export the contents stored in the TF

card the DCIM / Export directory.

4.7 File management

4.7.1 Playback

Two modes of playback:

___

File 20120654547.mp4

2R R

20120654548.mp4 20120654549 jpg 20120654550 jpg 20120654551 jpg

File Management Figure

1. File management mode: press the Enter key to pop up floating panel
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select "Settings" option to activate the main menu, select the file
management menu in the setup menu, press the confirm button to
open the infrared image in the storage. The image arrangement format
has abalone grid , press the upper, lower, left, and right arrow keys can
switched the stored image. Pressing the "C" key to exit open image and

return to the measurement state.

Preview Mode Figure
2. Preview mode: press the OK button to pop-up floating panel to select
"Preview" option, enter the preview mode. Through the left and right
keys to switch selection, selected press the OK button to enter the
playback. Pressing the "C" key to exit open image and return to the

measurement state.

Ere—

25 K07 \ ¢

Video Playback Interface
Video playback interface: Via the left and right key to select the play
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button on the status bar, press the "confirm" key to take effect on the next key
to show and hide the playback status bar (press the "on" button is displayed,
press the "next" button is hidden)

The icon buttons from left to right is as follow: play / pause, stop, rewind,

fast-forward, the former one, the next.

Image Playback Interface
The image playback interface: Via the left, right key to select the play
button on the status bar, press the "confirm" key to take effect on the next key
to show and hide the playback status bar (press the "on" button is displayed,
press the "next" button is hidden)
The icon buttons from left to right is as follows: the former one (above),

the next (paragraph), sound recording, voice playback, text playback.

4.7.2 Delete

This function is used to delete data stored in files on the TF card. Open File
Manager by the up and down keys to select the file you want to delete, press
the "S" key to bring up the prompt box, delete the currently selected image
files when the Enter key is pressed, the image voice or text comments will also

be deleted, then press the "C" key to undelete
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File Detele ?

20120654547 . mp4

20120654548.mp4  20120654549.jpg  20120654550,jpg  20120654551.jpg

File Delete Figure

I Note: Before deletion, make sure that the file is no longer needed or

have backup, the deleted image can not be recovered
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5 Specification

Items

Technical Specification

P-64
Detector Detector type Un-cooled FPA micro-bolometer
characteristics Array size/format 640x480

Field of view/min
focus distance

24°x18°/0.3m

Spatial resolution

Image

characteristics

(IFOV) 0.65mrad
Thermal sensitivity <0.03C@30C
Frame frequency 50/60Hz

Focus

Auto/Menu electronics focus

Digital zoom

8x,continuous zoom

Spectral range

8-14um

Built-in CCD camera

5.0 million pixels, LED lights

5" High resolution color touch LCD,

LCD display 800 x 480
Image display Fast switch between infrared image
Image and CCD image, with fusion and

picture in picture function

Temperature ranges -40°C- +650°C
+ 2 °C or = 2% of reading, Whichever
Accuracy .
is greater
Measurer_nent Automatic / manual
correction

Measurement mode

Up to 10 movable spots. Up to 5
movable areas(maximum, minimum
and average temperature). movable
lines. Line profile. Isotherms.
Temperature difference. Alarm(voice,
color)

Measurement
Image control

Color palette 11 palettes changeable

Auto/manual gain and brightness

Setup functions

Date/time, temperature unit,
language

Emissivity correction

Variable from 0.01 to 1.0

Background
temperature
correction

Automatic corrections according to
user input

Atmospheric
transmission
correction

Automatic correction according to user
input object distance, humidity and
temperature

Storage card

CF card(8G)

Mode
Image storage

Auto/manual saving, single thermal
images and CCD image link saving,
thermal and CCD fusion saving.

Thermal image format

JPEG (with radiometric information)
MPEG4(with radiometric information)
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CCD image format

JPEG. MPEG4

Voice annotation

Input via built-in microphone up to 60
seconds of digital voice clip per image
stored with image

Text annotation

Yes

Laser pointer

Laser locator

Class 2, 1Imw/635nm(red), IEC 60 285

Battery type

Li-Ion, rechargeable

Battery operating

3 hours continuous operation

time
Power source Battery charging Intelligent charger or power adaptor
mode 12V(optional) to random charge
Power saving Auto-sleep and auto-shut down
External power 10-15V DC
Operating 15C-- +50°C
. temperature
Environment Humidity <95% (nhon-condensing)
Encapsulation IP54
Tripod mounting 1/4"-20-UNC
Weight 1.7kg
Physical Dimension 245*180*150mm
characteristics External DC input YES
Video output PAL/NTSC

Communication port

Bluetooth; RJ45
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6 Troubleshooting

Please follow the table below to diagnose and correct the problem. If

problem still exists, please contact our service department.

Problem

Cause & Solution

The camera does not
power on.

Battery not installed or installed
incorrectly

—Install battery or re-install battery
Battery is out of power.

—Change battery.

“Power off” protection is enabled

—Wait for 5 seconds and reboot.

The camera
automatically.

powers  off

Battery is out of power.
—Change battery

AutoOffTime option is enabled
—Set as None.

Battery depletion is too fast

Environmental temperature is too low

Rechargeable battery is not charged

completely.

—Recharge the battery.

Rechargeable battery is out of power

completely and cannot be recharged.
—Change to new battery.

No thermal image

Lens cover is not removed.
—Remove lens cover.

In image freeze status
—Press C key to exit.

Thermal image is white-black.

White-black palette is selected
—Select normal palette.
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Appendix A

Common material emissivity (Fv1)

Material Surface Temperature°C Emissivity (&)

Non- oxidized 100 0.20
Aluminum

Oxidized 100 0.55

Burnished to Brown |20 0.40
Brass Dull luster 38 0.22

Oxidized 100 0.61
Copper Seriously Oxidized 20 0.78

Oxidized 100 0.74
Iron

Rusty 25 0.65

Oxidized 200 0.64
Cast iron

Non- Oxidized 100 0.21

Quarry-faced 25 0.94
Wrought iron

Polished 38 0.28
Nickel Oxidized 200 0.37
Stainless steel Oxidized 60 0.85
Steel Oxidized 200 0.79
Common brick Surface 20 0.93
Concrete Surface 20 0.92
Glass Polished plate 20 0.94

White 100 0.92
Lacquer

Black 100 0.97

Smoke black 25 0.95
Carbon Candle soot 20 0.95

Rough lead surface 20 0.98
Oil paint Value of 16 colors 100 0.94
Paper White 20 0.93
Sand soil Surface 20 0.90
Timber Dressed 20 0.90
Water Distilled water 20 0.96
Skin Human 32 0.98
Ceramic Thin 21 0.90

Thick 21 0.93
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Appendix B

Factory default parameter setting table

Table.1 Measurement temperature

setting table

Value

Parameter

Temperature Range -40 ~ 650°C | -20-180°C
Lens Standard
Temp Unit °C

Ref Type Off

Ref Temp 30°C
Table.2 Measurement temperature correction table
Parameter Value
Emissivity 0.96
TCorrect 0°C
TAmbient Temp Off
Table.3 Analysis setting table

Parameter Value
Temp Alarm Off
Alarming Temp 50.0°C
Alarming Color None
Isotherm Color Off
Isotherm Temp 50.0°C
Isotherm Width 1.0°C
Table.4 System setting table

Parameter Value
Language English
Brightness 60%

Auto Calib 60S
Video Mode NTSC
Quick Access Laser sight
StandbyTime 5 mins
AutoOffTime 15 mins
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